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Abstract 

On Wednesday, March 27th 3305 Commander PublicStaticVoid stumbled upon a signal pattern 

appearing in the deep space audio during a routine audiological analysis of the Diamondback 

Explorer’s (DBX) computer system. The signal, dubbed ‘Landscape Signal’, was initially 

discovered in Sol and immediately reconfirmed in multiple other systems. Detection can be made 

by bringing the vessel to a complete stop in deep space and pointing the nose in the general 

direction of Sagittarius A*. In order to visualize the signal audio software such as Audacity or 

Sonic Visualizer is required. A request was made by CMDR Void to the researchers within 

Independent Raxxla Hunters to conduct an open and transparent investigation into the Landscape 

Signal. 

 

 

 
Landscape Signal 
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Audio Software and Signal Acquisition Guide 

Software: 

Sonic Visualizer: https://www.sonicvisualiser.org/ 

Audacity: https://www.audacityteam.org/download/ 

Quick start (Sonic Visualizer): 

1. Open a FLAC recording 

2. Pane > Spectrogram 

3. Click the X to hide the waveform, unless you want it for some reason 

4. File > Export the spectrogram as SVG (very high res files, if doing image analysis) or 

some other format (PNG, JPG for posting) 

Sonic Visualiser 

Sonic Visualiser is a program for viewing and analysing the contents of music audio files. 

Quick Start (Audacity):  

1. Adjust microphone settings so that you can record Elite while playing (For me, I had to 

choose Windows WSAPI + Realtek Audio to get it to record). 

2. Press R to record. 

3. In the pulldown that says 'Audio Recording', choose 'Spectrogram' 

4. If you are pointing in the general area of the signal, you should see the signal within 2 

minutes. 

The signal varies in strength (a little, a 4 might appear as a 3 in one loop), a faint signal 

may require you to watch for 4-6 minutes.  An extremely faint signal may require you to 

export the recording (as FLAC) and open in Sonic Visualizer 

https://www.sonicvisualiser.org/
https://www.audacityteam.org/download/


LANDSCAPE SIGNAL 4 

5. Press the Stop button to stop recording.  You can delete parts of the recording when 

stopped.  To append to a previous recording, press Shift+R 

Checking for any signal with audacity: 

1. Exit supercruise and enter normal space 

2. Aim at point you want to check for a signal (center the dot in your screen) 

3. Modules > Disable Thrusters 

4. Go to Options > Audio, set Sound Effects to max Volume and put Music and Voice on 

Muted.  Set audio to "Full Range" as well 

5. Aim back at the center of the screen 

6. Start recording.  If you are aiming with ~120 degrees of the signal, it should be at least 

partially detectable.  The most recognizable part is the "Tail" 

Taking a pristine recording for analysis: 

1. Exit supercruise and enter normal space 

2. Center the point you want to aim at on the screen 

3. Take a screenshot (F10 by default in windows; stored in \Pictures\Frontier 

Developments\Elite Dangerous) 

4. Pull up the screenshot, preferably on 2nd monitor 

5. In Elite, use the Free Camera (Default: Ctrl+Alt+Space, then Num 0) 

6. Fly the camera in front of the ship and try to line up the center of the image as before, 

using your screenshot for reference now that the targeting circle is gone 

7. Go to Options > Audio, set Sound Effects to max Volume and put Music and Voice on 

Muted.  Set audio to "Full Range". 
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8. Record audio (20 minute preferred for audio analysis, at least 6 minutes for showing 

signal strength) 

9. Save as FLAC (unless the audio team wants a different format).  In the Notes section, 

record what system you were in and what you were facing 
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Landscape Signal – An Investigative Report It’s Point of Origin 

A Study into Signal Acquisition 

During the initial phase of the investigation multiple researchers began dumping 

positional data and signal acquisition data into the IRH’s #embr-signals Discord channel and 

launched missions to the core of the galaxy to further help study this signal. The data was swiftly 

compiled to paint a picture of how orientation affects signal strength. During the infancy of the 

investigation it was believed the signal could be acquired 180 degrees from wingtip to wing tip 

thus simple signal strengths models were compiled with greens and yellows indicating signal 

acquisitions bearings and reds indicating the loss of the signal bearings.  
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The dedication of a few Elite explorers used this crude methodology to swiftly narrow the signal 

down to a few tens of systems within the Galactic Center. The position of these stars lies 

relatively near Sagittarius A* (Within a few tens of light years). 

 

Methods for narrowing the signal’s origin down further required a more precise understanding of 

signal acquisition and much more data. An IRH researcher thus developed the positional angle 

calculator to help determine that signal angles of acquisition. This tool lead to the understanding 

that signal acquisition angles are predicated on not only positional data but also the software 

being used to analyze the signal. Signal reception is ~72 degrees from center within Audacity 

and ~75 degrees from center within Sonic Visualizer.  

 

https://docs.google.com/spreadsheets/d/1ifMgBUn9Uvqpt_6p7WPkopNvrOetDaRjZAsmG2rwFv4/edit#gid=93559264
https://docs.google.com/spreadsheets/d/1ifMgBUn9Uvqpt_6p7WPkopNvrOetDaRjZAsmG2rwFv4/edit#gid=93559264
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Signal Grading 

A method to determine signal strength visually within Audacity or Sonic Visualizer was 

constructed to aid in locating the POO. All signals are broken into 5 strength levels. A strength 

level of 0 indicates that no signal has been detected. Red was chosen to represent this signal 

grade in future graphs and graphics. 

Strength grade 1 indicates that the tail feature of the signal is barely detectable with no other 

features being apparent. Strength grade 2 indicates that the Mountain feature and the Tail are 

detectable however, the Ridge is not detectable. Due to minor deviations in signal strength as a 

result of random filters, grades 1 and 2 are both represented in graphs and graphics using Yellow. 

The final two signal grades, 3 and 4, are represented with Green in graphs. Both signal grades 

can be determined based on the presence of the Mountain feature, the Ridge feature, and the Tail 



LANDSCAPE SIGNAL 9 

feature. Grading between ‘3’ and ‘4’ is dependent upon how pronounced these features appear 

within the spectrogram.    

 

Pinpointing the Point of Origin (POO) 

Data was collected by multiple researchers and used to narrow the signal source down to a 

handful of closely positioned systems: 

JUENAE AC-B D1-10264 

JUENAE AJ-C C2-1768 

JUENAE BC-B D1-2830 

JUENAE PS-L A7-41 

JUENAE VC-E C1-2212 

JUENAE VC-E C1-2355 

JUENAE ZI-C C2-1883 

JUENAE ZI-C C2-3115 

STUEMEAE FG-Y C7033 

STUEMEAE GG-Y C3247 

STUEMEAE GG-Y C8204 

Multiple measurements were taken in these systems to develop a <X, Y> weighted scatter plot 

representation of the signal data. The Z axis was ignored for visualization purposes.  
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A bidirectional signal detected triangle was discovered between systems JUENAE AC-B D1-10264,  

JUENAE PS-L A7-41, and JUENAE AJ-C C2-1768. 

Logical Condition: 

There exists a location such that signal acquisition is bidirectional in all bearing permutations of star sets  

[A,B,C] inferring that some signal source exists between [A,B,C] 

Proof: 

[A] JUENAE AC-B D1-10264 [B] JUENAE PS-L A7-41 [C] JUENAE AJ-C C2-1768 

The following permutations were observed to have the following signal grades: 

A -> B: Signal Grade of 4 

B -> A: Signal Grade of 3 

B -> C: Signal Grade of 4 

C -> B: Signal Grade of 4 

C -> A: Signal Grade of 4 

A -> C: Signal Grade of 3 

A <-> B <-> C <-> A 

Thus it can be inferred that the source of the Landscape signal is in between points A, B, and C.  
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To further prove the location of the source is between [A,B,C] beyond simply the logical condition being 

met, an additional measurement was taken which bisects the triad of stars.  

Logical Condition: 

If a signal source does exist between points [A, B, C] then there also exists an edge between a set of 

points [D, E] that bisects [A,B,C] such that a bidirectional signal acquisition of maximum grade 4 is 

observed:.  

Proof: 

[D] : Juenae ZI-C c2-3115 

[E]: Stuemeae GG-Y c4801 

D -> E: Signal Grade of 4 

E -> D: Signal Grade of 4 

 

Additional measurements were also taken from point [D] to points [A, B, C] and with all signal strengths 

being of 3 or less, further proving the existence of the source between [A, B, C]. A 3D visual 
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representation of the this data has been established by an IRH researcher in order to better assist in 

visualization of the above proofs. [3d visualization model]  

 

Signal POO Conclusion 

It is thus concluded that the point of origin for the Landscape Signal is between the following 5 systems 

which if connected form a diamond around the source: 

[A] JUENAE AC-B D1-10264  

[B] JUENAE PS-L A7-41  

[C] JUENAE AJ-C C2-1768 

[D] JUENAE ZI-C C2-3115 

[E]: STUEMEAE GG-Y C4801 

 

https://youtu.be/j6KMqFAw2JU
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Raw Measurement Data 

Raw Signal Data: 

Host System Cordinates Observed System Cordinates Signal Strength 
JUENAE AC-
B D1-10264 

14.96875/-
26.25/25896.5 JUENAE AJ-C C2-1768 

17 / -26.124 / 
25895.09375 3 

JUENAE AC-
B D1-10264 

14.96875/-
26.25/25896.6 JUENAE PS-L A7-41 

14/-
25.03125/25892.625  4 

JUENAE AC-
B D1-10264 

14.96875/-
26.25/25896.7 JUENAE ZI-C C2-3115 

14.59375/-
27.3125/25895.3125 0 

JUENAE AC-
B D1-10264 

14.96875/-
26.25/25896.8  JUENAE VC-E C1-2212 

13.46875/-
26.6875/25893.9375 2 

JUENAE AC-
B D1-10264 

14.96875/-
26.25/25896.9 JUENAE ZI-C C2-1883 

13.1875/-
26.09375/25892.96875 1 

JUENAE AC-
B D1-10264 

14.96875/-
26.25/25896.10 JUENAE VC-E C1-2355 

13.1875/-
26.09375/25892.96875 4 

JUENAE AC-
B D1-10264 

14.96875/-
26.25/25896.11 JUENAE BC-B D1-2830 

17.53125/-
25.78125/25896.40625  0 

JUENAE AC-
B D1-10264 

14.96875/-
26.25/25896.12 STUEMEAE GG-Y C8204 

16.5/-
22.3125/25893.03125 4 

JUENAE AC-
B D1-10264 

14.96875/-
26.25/25896.13 STUEMEAE GG-Y C3247 

15.34375/-
23.71875/25891.625  4 

JUENAE AC-
B D1-10264 

14.96875/-
26.25/25896.14 STUEMEAE FG-Y C7033 

13.21875/-
24.28125/25891.65625 3 

JUENAE AC-
B D1-10264 

17 / -26.124 / 
25895.09375 Sagittarius A* 

25.21875 / -20.90625 / 
25899.96875 0 

JUENAE PS-L 
A7-41 

14/-
25.03125/25892.625  JUENAE AJ-C C2-1768 

17 / -26.124 / 
25895.09375 4 

JUENAE PS-L 
A7-41 

14/-
25.03125/25892.625  JUENAE AC-B D1-10264 

14.96875/-
26.25/25896.5 3 

JUENAE PS-L 
A7-41 

14/-
25.03125/25892.625 JUENAE ZI-C C2-3115 

14.59375/-
27.3125/25895.3125  

JUENAE PS-L 
A7-41 

14/-
25.03125/25892.625  JUENAE VC-E C1-2212 

13.46875/-
26.6875/25893.9375 1 

JUENAE PS-L 
A7-41 

14/-
25.03125/25892.625  JUENAE ZI-C C2-1883 

13.1875/-
26.09375/25892.96875 2 

JUENAE PS-L 
A7-41 

14/-
25.03125/25892.625 JUENAE VC-E C1-2355 

13.1875/-
26.09375/25892.96875  

JUENAE PS-L 
A7-41 

14/-
25.03125/25892.625 JUENAE BC-B D1-2830 

17.53125/-
25.78125/25896.40625  4 

JUENAE PS-L 
A7-41 

14/-
25.03125/25892.625 STUEMEAE GG-Y C8204 

16.5/-
22.3125/25893.03125 0 

JUENAE PS-L 
A7-41 

14/-
25.03125/25892.625 STUEMEAE GG-Y C3247 

15.34375/-
23.71875/25891.625   

JUENAE PS-L 
A7-41 

14/-
25.03125/25892.625 STUEMEAE FG-Y C7033 

13.21875/-
24.28125/25891.65625 0 
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JUENAE PS-L 
A7-41 

14/-
25.03125/25892.625 Sagittarius A* 

25.21875 / -20.90625 / 
25899.96875 4 

JUENAE AJ-C 
C2-1768 

17 / -26.124 / 
25895.09375 JUENAE AC-B D1-10264 

14.96875/-
26.25/25896.5 4 

JUENAE AJ-C 
C2-1768 

17 / -26.124 / 
25895.09375 JUENAE PS-L A7-41 

14/-
25.03125/25892.625  4 

JUENAE AJ-C 
C2-1768 

17 / -26.124 / 
25895.09375 JUENAE ZI-C C2-3115 

14.59375/-
27.3125/25895.3125 1 

JUENAE AJ-C 
C2-1768 

17 / -26.124 / 
25895.09375  JUENAE VC-E C1-2212 

13.46875/-
26.6875/25893.9375 3 

JUENAE AJ-C 
C2-1768 

17 / -26.124 / 
25895.09375  JUENAE ZI-C C2-1883 

13.1875/-
26.09375/25892.96875 4 

JUENAE AJ-C 
C2-1768 

17 / -26.124 / 
25895.09375 JUENAE VC-E C1-2355 

13.1875/-
26.09375/25892.96875 3 

JUENAE AJ-C 
C2-1768 

17 / -26.124 / 
25895.09375 JUENAE BC-B D1-2830 

17.53125/-
25.78125/25896.40625  0 

JUENAE AJ-C 
C2-1768 

17 / -26.124 / 
25895.09375 STUEMEAE GG-Y C8204 

16.5/-
22.3125/25893.03125 3 

JUENAE AJ-C 
C2-1768 

17 / -26.124 / 
25895.09375 STUEMEAE GG-Y C3247 

15.34375/-
23.71875/25891.625  3 

JUENAE AJ-C 
C2-1768 

17 / -26.124 / 
25895.09375 STUEMEAE FG-Y C7033 

13.21875/-
24.28125/25891.65625 3 

JUENAE AJ-C 
C2-1768 

17 / -26.124 / 
25895.09375 Sagittarius A* 

25.21875 / -20.90625 / 
25899.96875 0 

 

Systems Nearby 

From To Distance 

JUENAE WC-E C1-437 JUENAE AC-B D1-10264 3.07 

STUEMEAE GG-Y C4601 JUENAE AC-B D1-10264 3.3 

STUEMEAE JM-W C1-5825 JUENAE AC-B D1-10264 1.96 

JUENAE WC-E C1-437 JUENAE AC-B D1-2051 4.27 

STUEMEAE JM-W C1-5825 JUENAE AC-B D1-2051 3.57 

JUENAE WC-E C1-437 JUENAE AJ-C C2-1589 3.44 

JUENAE WC-E C1-437 JUENAE AJ-C C2-1768 1.79 

STUEMEAE GG-Y C4601 JUENAE AJ-C C2-1768 3.06 

STUEMEAE JM-W C1-5825 JUENAE AJ-C C2-1768 2.87 

JUENAE WC-E C1-437 JUENAE AJ-C C2-3815 4 

JUENAE WC-E C1-437 JUENAE AJ-C C2-4124 3.65 

JUENAE WC-E C1-437 JUENAE BC-B D1-2830 3.23 

STUEMEAE GG-Y C4601 JUENAE BC-B D1-2830 3.42 

STUEMEAE JM-W C1-5825 JUENAE BC-B D1-2830 3.43 

JUENAE WC-E C1-437 JUENAE PS-L A7-2 3.05 
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JUENAE WC-E C1-437 JUENAE PS-L A7-26 4.2 

JUENAE WC-E C1-437 JUENAE PS-L A7-41 2.68 

STUEMEAE GG-Y C4601 JUENAE PS-L A7-41 3.17 

STUEMEAE JM-W C1-5825 JUENAE PS-L A7-41 2.67 

JUENAE WC-E C1-437 JUENAE QS-L A7-21 3.02 

JUENAE WC-E C1-437 JUENAE QS-L A7-22 4 

JUENAE WC-E C1-437 JUENAE QS-L A7-3 3.81 

JUENAE WC-E C1-437 JUENAE QS-L A7-32 4.06 

JUENAE WC-E C1-437 JUENAE QS-L A7-40 3.77 

JUENAE WC-E C1-437 JUENAE QS-L A7-42 3.94 

JUENAE WC-E C1-437 JUENAE QS-L A7-44 2.15 

JUENAE WC-E C1-437 JUENAE QS-L A7-59 4.29 

STUEMEAE JM-W C1-5825 JUENAE TY-J A8-30 3.33 

STUEMEAE JM-W C1-5825 JUENAE TY-J A8-35 3.19 

STUEMEAE JM-W C1-5825 JUENAE TY-J A8-50 2.73 

JUENAE WC-E C1-437 JUENAE TY-J AB-35 3.63 

STUEMEAE JM-W C1-5825 JUENAE TY-J AB-71 3.8 

STUEMEAE GG-Y C4601 JUENAE UY-J A8-15 3.8 

STUEMEAE GG-Y C4601 JUENAE UY-J A8-21 2.64 

STUEMEAE JM-W C1-5825 JUENAE UY-J A8-21 3.14 

JUENAE WC-E C1-437 JUENAE UY-J A8-49 4.11 

STUEMEAE GG-Y C4601 JUENAE UY-J A8-49 3.68 

JUENAE WC-E C1-437 JUENAE UY-J A8-65 4.2 

STUEMEAE JM-W C1-5825 JUENAE UY-J AB-149 3.73 

JUENAE WC-E C1-437 JUENAE UY-J AB-15 3.47 

JUENAE WC-E C1-437 JUENAE UY-J AB-21 2.84 

JUENAE WC-E C1-437 JUENAE UY-J AB-52 4.21 

STUEMEAE JM-W C1-5825 JUENAE UY-J AB8-15 3.75 

JUENAE WC-E C1-437 JUENAE VC-E C1-2212 2.59 

STUEMEAE GG-Y C4601 JUENAE VC-E C1-2212 3.98 

STUEMEAE JM-W C1-5825 JUENAE VC-E C1-2212 2.46 

JUENAE WC-E C1-437 JUENAE VC-E C1-2355 2.94 

STUEMEAE GG-Y C4601 JUENAE VC-E C1-2355 4.04 

STUEMEAE JM-W C1-5825 JUENAE VC-E C1-2355 2.89 

STUEMEAE JM-W C1-5825 JUENAE VC-E C1-2575 3.6 

STUEMEAE JM-W C1-5825 JUENAE VC-E C1-956 3.38 

JUENAE WC-E C1-437 JUENAE WC-E C1-1108 4.12 

JUENAE WC-E C1-437 JUENAE WC-E C1-1813 2.3 

JUENAE WC-E C1-437 JUENAE WC-E C1-2065 3.36 

JUENAE WC-E C1-437 JUENAE WC-E C1-2798 4.06 

JUENAE WC-E C1-437 JUENAE WC-E C1-2812 3.8 
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STUEMEAE GG-Y C4601 JUENAE WC-E C1-437 3.31 

STUEMEAE JM-W C1-5825 JUENAE WC-E C1-437 2.8 

JUENAE WC-E C1-437 JUENAE WV-C D6157 3.97 

STUEMEAE JM-W C1-5825 JUENAE WV-C D8798 3.23 

JUENAE WC-E C1-437 JUENAE XV-C D3417 3.49 

JUENAE WC-E C1-437 JUENAE XV-C D6637 4.24 

JUENAE WC-E C1-437 JUENAE XV-C D7723 3.81 

JUENAE WC-E C1-437 JUENAE XV-C D7878 1.7 

STUEMEAE JM-W C1-5825 JUENAE XV-C D7878 3.92 

JUENAE WC-E C1-437 JUENAE XV-C D8022 1.91 

JUENAE WC-E C1-437 JUENAE ZI-C C2-1883 3.29 

STUEMEAE GG-Y C4601 JUENAE ZI-C C2-1883 4.01 

STUEMEAE JM-W C1-5825 JUENAE ZI-C C2-1883 2.19 

STUEMEAE JM-W C1-5825 JUENAE ZI-C C2-2669 3.27 

STUEMEAE JM-W C1-5825 JUENAE ZI-C C2-275 3.43 

JUENAE WC-E C1-437 JUENAE ZI-C C2-3115 2.37 

STUEMEAE GG-Y C4601 JUENAE ZI-C C2-3115 4.02 

STUEMEAE JM-W C1-5825 JUENAE ZI-C C2-3115 2.47 

JUENAE WC-E C1-437 STUEMAE GG-Y C4601 3.31 

JUENAE WC-E C1-437 STUEMAEAE FG-Y C4670 3.56 

STUEMEAE GG-Y C4601 STUEMEAE AA-A D680 3.12 

STUEMEAE GG-Y C4601 STUEMEAE AA-A E2215 3.35 

JUENAE WC-E C1-437 STUEMEAE BA-A D2966 4.21 

STUEMEAE GG-Y C4601 STUEMEAE BA-A D4801 3.27 

STUEMEAE GG-Y C4601 STUEMEAE EG-Y D1236 4.05 

STUEMEAE JM-W C1-5825 STUEMEAE EG-Y D1236 3.79 

STUEMEAE GG-Y C4601 STUEMEAE EG-Y D3742 2.55 

STUEMEAE JM-W C1-5825 STUEMEAE EG-Y D3742 2.38 

STUEMEAE GG-Y C4601 STUEMEAE FG-Y C1226 3.38 

STUEMEAE JM-W C1-5825 STUEMEAE FG-Y C1226 2.21 

STUEMEAE GG-Y C4601 STUEMEAE FG-Y C1606 2.89 

STUEMEAE JM-W C1-5825 STUEMEAE FG-Y C1606 3.72 

STUEMEAE GG-Y C4601 STUEMEAE FG-Y C2239 3.95 

STUEMEAE JM-W C1-5825 STUEMEAE FG-Y C2239 3.53 

STUEMEAE JM-W C1-5825 STUEMEAE FG-Y C2613 3.14 

STUEMEAE GG-Y C4601 STUEMEAE FG-Y C3277 3.93 

STUEMEAE JM-W C1-5825 STUEMEAE FG-Y C3277 3.92 

STUEMEAE GG-Y C4601 STUEMEAE FG-Y C4670 1.71 

STUEMEAE JM-W C1-5825 STUEMEAE FG-Y C4670 2.04 

STUEMEAE GG-Y C4601 STUEMEAE FG-Y C6255 3.14 

STUEMEAE JM-W C1-5825 STUEMEAE FG-Y C6255 4.02 
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JUENAE WC-E C1-437 STUEMEAE FG-Y C7033 4.07 

STUEMEAE GG-Y C4601 STUEMEAE FG-Y C7033 4.07 

STUEMEAE JM-W C1-5825 STUEMEAE FG-Y C7033 3.84 

STUEMEAE JM-W C1-5825 STUEMEAE FG-Y C7947 3.38 

STUEMEAE GG-Y C4601 STUEMEAE FG-Y C8259 3.21 

STUEMEAE JM-W C1-5825 STUEMEAE FG-Y C8259 2.32 

STUEMEAE GG-Y C4601 STUEMEAE FG-Y C9007 4.03 

STUEMEAE GG-Y C4601 STUEMEAE FG-Y D4785 3.98 

STUEMEAE GG-Y C4601 STUEMEAE FG-Y D7550 3.38 

STUEMEAE GG-Y C4601 STUEMEAE GF-Y C2613 3.1 

STUEMEAE GG-Y C4601 STUEMEAE GF-Y C7947 2.38 

STUEMEAE JM-W C1-5825 STUEMEAE GG-Y 4601 1.84 

JUENAE WC-E C1-437 STUEMEAE GG-Y C3247 3.47 

STUEMEAE GG-Y C4601 STUEMEAE GG-Y C3247 3.27 

STUEMEAE JM-W C1-5825 STUEMEAE GG-Y C3247 3.9 

JUENAE WC-E C1-437 STUEMEAE GGY C4325 3.94 

STUEMEAE GG-Y C4601 STUEMEAE GG-Y C4325 4.01 

STUEMEAE GG-Y C4601 STUEMEAE GG-Y C4801 2.07 

STUEMEAE JM-W C1-5825 STUEMEAE GG-Y C4801 3.86 

STUEMEAE GG-Y C4601 STUEMEAE GG-Y C5269 3.08 

STUEMEAE GG-Y C4601 STUEMEAE GG-Y C6471 3.33 

STUEMEAE GG-Y C4601 STUEMEAE GG-Y C7652 2.48 

JUENAE WC-E C1-437 STUEMEAE GG-Y C8204 4.22 

STUEMEAE GG-Y C4601 STUEMEAE GG-Y C8204 2.35 

STUEMEAE JM-W C1-5825 STUEMEAE GG-Y C8204 3.95 

JUENAE WC-E C1-437 STUEMEAE GG-Y C8350 4.14 

STUEMEAE GG-Y C4601 STUEMEAE GG-Y C8350 3.22 

STUEMEAE GG-Y C4601 STUEMEAE JM-W C1-1077 3.82 

STUEMEAE GG-Y C4601 STUEMEAE JM-W C1-2074 4.11 

STUEMEAE JM-W C1-5825 STUEMEAE JM-W C1-2074 3.57 

STUEMEAE JM-W C1-5825 STUEMEAE JM-W C1-2319 4.09 

STUEMEAE GG-Y C4601 STUEMEAE JM-W C1-2953 3.28 

STUEMEAE JM-W C1-5825 STUEMEAE JM-W C1-2953 2.47 

STUEMEAE JM-W C1-5825 STUEMEAE JM-W C1-3826 3.41 

STUEMEAE GG-Y C4601 STUEMEAE JM-W C1-5579 2.7 

STUEMEAE JM-W C1-5825 STUEMEAE JM-W C1-5579 3.36 

JUENAE WC-E C1-437 STUEMEAE JM-W C1-5825 2.8 

STUEMEAE GG-Y C4601 STUEMEAE JM-W C1-5825 1.84 

STUEMEAE GG-Y C4601 STUEMEAE JM-W C1-8118 3.55 

STUEMEAE GG-Y C4601 STUEMEAE KM-W C1-6701 3.88 

STUEMEAE GG-Y C4601 STUEMEAE KM-W C1-7529 3.37 
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STUEMEAE JM-W C1-5825 STUEMEAE KM-W C1-7529 3.66 

STUEMEAE JM-W C1-5825 STUEMEAE PS-U B2-139 3.15 

STUEMEAE JM-W C1-5825 STUEMEAE PS-U B2-166 4.07 

JUENAE WC-E C1-437 STUEMEAE QS-U B2-142 3.57 

STUEMEAE GG-Y C4601 STUEMEAE QS-U B2-142 3.53 

STUEMEAE GG-Y C4601 STUEMEAE QS-U B2-17 3.4 

STUEMEAE GG-Y C4601 STUEMEAE TY-S B3-29 2.32 

STUEMEAE JM-W C1-5825 STUEMEAE TY-S B3-29 3.5 

 

Closest Shared 

From To Distance 
Average 
Distance 

        

JUENAE WC-E C1-437 JUENAE AC-B D1-10264 3.07   

STUEMEAE GG-Y C4601 JUENAE AC-B D1-10264 3.3 2.776666667 

STUEMEAE JM-W C1-5825 JUENAE AC-B D1-10264 1.96   

        

JUENAE WC-E C1-437 JUENAE AJ-C C2-1768 1.79   

STUEMEAE GG-Y C4601 JUENAE AJ-C C2-1768 3.06 2.573333333 

STUEMEAE JM-W C1-5825 JUENAE AJ-C C2-1768 2.87   

        

JUENAE WC-E C1-437 JUENAE BC-B D1-2830 3.23   

STUEMEAE GG-Y C4601 JUENAE BC-B D1-2830 3.42 3.36 

STUEMEAE JM-W C1-5825 JUENAE BC-B D1-2830 3.43   

        

JUENAE WC-E C1-437 JUENAE PS-L A7-41 2.68   

STUEMEAE GG-Y C4601 JUENAE PS-L A7-41 3.17 2.84 

STUEMEAE JM-W C1-5825 JUENAE PS-L A7-41 2.67   

        

JUENAE WC-E C1-437 JUENAE VC-E C1-2212 2.59   

STUEMEAE GG-Y C4601 JUENAE VC-E C1-2212 3.98 3.01 

STUEMEAE JM-W C1-5825 JUENAE VC-E C1-2212 2.46   

        

JUENAE WC-E C1-437 JUENAE VC-E C1-2355 2.94   

STUEMEAE GG-Y C4601 JUENAE VC-E C1-2355 4.04 3.29 

STUEMEAE JM-W C1-5825 JUENAE VC-E C1-2355 2.89   

        

JUENAE WC-E C1-437 JUENAE ZI-C C2-1883 3.29   

STUEMEAE GG-Y C4601 JUENAE ZI-C C2-1883 4.01 3.163333333 
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STUEMEAE JM-W C1-5825 JUENAE ZI-C C2-1883 2.19   

        

JUENAE WC-E C1-437 JUENAE ZI-C C2-3115 2.37   

STUEMEAE GG-Y C4601 JUENAE ZI-C C2-3115 4.02 2.953333333 

STUEMEAE JM-W C1-5825 JUENAE ZI-C C2-3115 2.47   

        

JUENAE WC-E C1-437 STUEMEAE FG-Y C7033 4.07   

STUEMEAE GG-Y C4601 STUEMEAE FG-Y C7033 4.07 3.993333333 

STUEMEAE JM-W C1-5825 STUEMEAE FG-Y C7033 3.84   

        

JUENAE WC-E C1-437 STUEMEAE GG-Y C3247 3.47   

STUEMEAE GG-Y C4601 STUEMEAE GG-Y C3247 3.27 3.546666667 

STUEMEAE JM-W C1-5825 STUEMEAE GG-Y C3247 3.9   

        

JUENAE WC-E C1-437 STUEMEAE GG-Y C8204 4.22   

STUEMEAE GG-Y C4601 STUEMEAE GG-Y C8204 2.35 3.506666667 

STUEMEAE JM-W C1-5825 STUEMEAE GG-Y C8204 3.95   

 


